AVAYA

Avaya Solution & Interoperability Test Lab

Application Notes for Configuring the Accelerated
Connections SIP Trunking Service with Avaya IP Office
Release 8.1 and Avaya Session Border Controller for
Enterprise 6.2 — Issue 1.0

Abstract

These Application Notes describe the steps to configure Session Initiation Protocol (SIP)
Trunking between Accelerated Connections and an enterprise solution using Avaya IP Office
Release 8.1 and Avaya Session Border Controller for Enterprise 6.2.

The Accelerated Connections SIP Trunking Service provides PSTN access via a SIP trunk
between the enterprise and the Accelerated Connections network as an alternative to legacy
analog or digital trunks. This approach generally results in lower cost for the enterprise.
Accelerated Connections is a member of the Avaya DevConnect Service Provider program.

Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describes the steps to configure Session Initiation Protocol (SIP)
Trunking between Accelerated Connections and an enterprise solution using Avaya IP Office
Release 8.1 and Avaya Session Border Controller for Enterprise 6.2.

The Accelerated Connections SIP Trunking Service referenced within these Application Notes is
positioned for customers that have an IP-PBX or IP-based network equipment with SIP
functionality, but need a form of IP transport and local services to complete their solution.

The Accelerated Connections SIP Trunking Service will enable delivery of origination and
termination of local, long-distance and toll-free traffic across a single broadband connection. A
SIP signaling interface will be enabled to the Customer Premises Equipment (CPE).

2. General Test Approach and Test Results

The general test approach was to connect a simulated enterprise site to the Accelerated
Connections SIP Trunking Service via the public Internet and exercise the features and
functionality listed in Section 2.1. The simulated enterprise site was comprised of Avaya IP
Office, Avaya Session Border Controller for Enterprise (Avaya SBCE) and various Avaya
endpoints listed in Section 4.

The Accelerated Connections SIP Trunking Service passed compliance testing with any
observations or limitations described in Section 2.2.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

e Sending/receiving SIP OPTIONS queries to/from the service provider.

e Incoming PSTN calls to SIP and H.323 telephones at the enterprise. All inbound PSTN
calls were routed to the enterprise across the SIP trunk from the service provider.

e Qutgoing PSTN calls from SIP and H.323 telephones at the enterprise. All outgoing
PSTN calls were routed from the enterprise across the SIP trunk to the service provider.

¢ Inbound and outbound PSTN calls to/from soft clients. Avaya IP Office Video
Softphone and Avaya Flare® Experience for Windows were tested.

e Various call types including: local, long distance, outbound toll-free, international and
local directory assistance.
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Codec G.711MU and G.729A.

T.38 Fax.

Caller ID presentation and Caller 1D restriction.

DTMF transmission using RFC 2833.

Voicemail navigation using DTMF input for inbound and outbound calls.
User features such as hold and resume, transfer, and conference.

Off-net call forwarding and twinning.

Inbound toll-free calls and 911 emergency calls are supported but were not tested as part of
the compliance test.

The following items are not supported:

Operator (dial 0) and operator-assisted (dial 0 + 10 digits) services.
REFER method for call redirection.

In addition, the following configuration settings are highlighted as possible common problem

areas.

On the Accelerated Connections Genband S3 session border controller, the
sipdialogidentification flag must be enabled to allow proper operation of the session
timers (e.g., long duration calls) and enterprise to enterprise calls dialed using the full
DID numbers. See Section 7.

On IP Office, enable RTP keepalives to ensure reliable audio on inbound calls that are
forwarded to the PSTN. See Section 5.2.1.

On the IP Office SIP Line, disable use of the P-Asserted-ldentity (PAI) header. Different
PSTN carriers used by Accelerated Connections would use the contents of different SIP
headers to display the calling party number. Removing the use of the PAI header
provided the expected calling party number across the different PSTN carriers
encountered in the compliance test, especially for the call forwarding and twinning
scenarios. See Section 5.4.4.

2.2. Test Results

Interoperability testing of the Accelerated Connections SIP Trunking Service was completed
with successful results for all test cases with the exception of the observations/limitations
described below.

Calling Party Number on inbound calls: On inbound calls from a specific test number,
the last digit of the inbound calling party 11-digit number is truncated in the SIP From
header. This leads to an incorrect calling party number of 1 + 9 digits being displayed at
the enterprise. Upon investigation, Accelerated Connections determined that the
incorrect number was being received from the PSTN carrier. A ticket was raised with the
PSTN carrier.
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e Codec not locked down on outbound calls: On outbound calls, Accelerated
Connections responds to the INVITE request with multiple codecs, instead of selecting
one from the INVITE SDP list. IP Office uses the first compatible codec in the list. This
behavior has no user impact. Calls were successful.

e Blind transfer with Avaya 1100 IP Deskphones calling party number: An Avaya
1100 Series IP Deskphone (SIP) places an outbound call to the PSTN, then performs a
blind transfer of this call to another PSTN endpoint. In this scenario, the wrong calling
party number is displayed on the second PSTN endpoint. The display shows the number
dialed by the Avaya 1100 Series IP Deskphone for the initial outbound call including the
short code (9) + 1 + 10 digits. The behavior is expected to be the same as with IP Office
H.323 endpoints which is to display the transferring party number. This is an IP Office
issue that was fixed and tested in a development release. The fix will be available in a
future IP Office generally available (GA) release.

e T.38 Fax: If IP Office is configured to use T.38/Fallback for fax, outbound fax calls use
T.38 but on inbound calls IP Office never attempts to negotiate use of T.38. Instead, IP
Office always uses G.711 fax. To ensure use of T.38 fax for both inbound and outbound
calls, IP Office must be set to use T.38 only. This is under investigation.

2.3. Support

For technical support on the Accelerated Connections SIP Trunking Service, contact Accelerated
Connections using the Support links at www.acceleratedconnections.com or by calling 1-866-
814-1635.

3. Reference Configuration

Figure 1 illustrates the sample configuration used for the DevConnect compliance testing. The
sample configuration shows an enterprise site connected to the Accelerated Connections SIP
Trunking Service.

Located at the edge of the enterprise is the Avaya SBCE. It has a public side that connects to the
external network and a private side that connects to the enterprise network. All SIP and RTP
traffic entering or leaving the enterprise flows through the Avaya SBCE. In this way, the Avaya
SBCE can protect the enterprise against any SIP-based attacks. The Avaya SBCE provides
network address translation at both the IP and SIP layers.

The enterprise site contains an Avaya IP Office 500 V2 with various endpoints and a Windows
2003 Server running both Avaya IP Office Manager to configure the Avaya IP Office and Avaya
Preferred Edition for voicemail (also known as VVoiceMail Pro).
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http://www.acceleratedconnections.com/
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Figure 1: Avaya Interoperability Test Lab Configuration

For security purposes, any public IP addresses or PSTN routable phone numbers used in the
compliance test are not shown in these Application Notes. Instead, public IP addresses have
been replaced with private addresses and all phone numbers have been replaced with numbers
that cannot be routed over the PSTN.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to send digits
across the SIP trunk to Accelerated Connections. The short code of 9 and any preceding 1 is
stripped off by Avaya IP Office and the remaining 10 digits were sent unaltered to Accelerated
Connections. For inbound calls, the Accelerated Connections SIP Trunking Service sent 10
digits in the Request URI and the To field of inbound SIP INVITE messages.
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4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Avaya Telephony Components

Enterprise running on a Portwell CAD-0208
server

Equipment Software
Avaya IP Office 500 v2 8.1 (69)
Avaya IP Office Manager 10.1 (69)
Avaya IP Office Preferred Edition 8.1 (9203)
(Voicemail)
Avaya Session Border Controller for 6.2.0.Q36

Avaya 1140E IP Deskphone (SIP)

4.3 SP1 (04.03.12.00)

Avaya one-X® Deskphone Edition

Avaya 1608 IP Deskphone (H.323) running 1.3SP3(1.3.3)
Avaya one-X® Deskphone Value Edition
Avaya 9641G IP Deskphone (H.323) running 6.2 SP4 (6.2408)

Avaya IP Office Video Softphone (SIP)

3.2.3.48 (67009)

Avaya Flare® Experience for Windows

1.1.2.11

Accelerated Connections Components

Equipment

Software

Genband S3 Session Border Controller

7.1.13.0

Testing was performed with IP Office 500 V2 R8.1, but this testing also applies to IP Office
Server Edition R8.1. Note that IP Office Server Edition requires an Expansion IP Office 500 V2
R8.1 to support analog or digital endpoints or trunks. Also, IP Office 500 V2 does not support
SIP Direct Media so Server Edition SIP Direct Media functionality was not compliance tested.
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the
Avaya IP Office Manager PC, select Start - Programs > IP Office - Manager to launch the
application. A screen that includes the following in the center may be displayed:

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Oipen Configuration from System

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the
configuration may be alternatively opened by navigating to File > Open Configuration at the
top of the Avaya IP Office Manager window. Select the proper Avaya IP Office system from the
pop-up window and log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group Pane has been omitted, its content is shown as submenus in the Navigation
pane. These panes (Navigation, Group and Details) will be referenced throughout the Avaya IP
Office configuration. All licensing and feature configuration that is not directly related to the
interface with the service provider (such as twinning and IP Office Video Softphone support) is
assumed to already be in place.

In the sample configuration, Atlantic City was used as the system name. All navigation
described in the following sections (e.g., License = SIP Trunk Channels) appears as submenus
underneath the system name Atlantic City in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License -
SIP Trunk Channels in the Navigation pane. Confirm a valid license with sufficient Instances
(trunk channels) in the Details pane.

IP Offices B SIP Trunk Channels ek - |

= R BOOTP (4) Al | Licenses
+-4# Operator (3)
=39 Atlantic City License Key Tk o B sl # 1 | 3wc7x
+-=p System (1)
+-T4 Line (12) License Type  |SIP Trunk Channels
+-<=» Control Unit {33
+- e Extension (25)
+ = User {26)
+- 5 HuntGroup (1)
+-@% short Code (61) Expiry Date Mewer
B service (0)
H-ally RAS (1)
#-{p Incoming Call Raute (19
B8 wanPort (0)
aim Directory {0}
£179 Time Profile ()
+- {8} Firewall Profile (1)
+- [l IP Route (4)
#m Account Code (0)
- W License (77)
e 1600 Series Phones
W= 3rd Party IP Endpoil
. Advanced Edition
. Advanced Small Cor
B ALDIR Yoicemail
. Avaya IP endpoints
& Avava IP endpoints
W Branch Edition

License Status  |Valid

Instances 255
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To view the physical hardware comprising the IP Office system, expand the components under
the Control Unit in the Navigation pane. In the sample configuration, the second component
listed is @ Combination Card. This module has 6 digital stations ports, two analog extension
ports, 4 analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module
supporting VolIP codecs. An IP Office hardware configuration with a VCM component is
necessary to support SIP trunking.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the IP 500 V2.

IP Offices

- K BOOTP(4)
+-4{# Operator (3)
=42y Atlantic Ciky
+-y System (1)
+-F 7 Line {14)
=<2 Caontrol Unit {33
o 1IPSOONZ
o 2 COMBOGEZ10/ATM4
“ir 3 DIGSTAS/ATMY
+-4fy Extension (25)
+-§ User (27)
+ -1 HuntGroup (1)
+- @ short Code (61)

@ Service (0}

L

it

Device Murnber

Unit Type

Wersion

Serial Murmber

nit IP Address
Interconnect Mumber

Madule Murmber

IP 500 V2 £

1

IP 500 ¥z

8.1 (63}

Do
10.32.128.25
0

Contral Linik
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5.2. System
Configure the necessary system settings.

5.2.1. System — LAN1 Tab

In the sample configuration, the Avaya IP Office LAN port was used to connect to the enterprise
network. The LANL1 settings correspond to the LAN port on the Avaya IP Office 500 V2. To
access the LANL1 settings, first navigate to System = <Name>, where <Name> is the system
name assigned to the IP Office. In the case of the compliance test, the system name is Atlantic
City. Next, navigate to the LAN1 = LAN Settings tab in the Details Pane. Set the IP Address
field to the IP address assigned to the Avaya IP Office LAN port. Set the IP Mask field to the
mask used on the enterprise network. All other parameters should be set according to customer
requirements.

IP Offices = Atlantic City

R BOOTP (4) Systern | LANL | LANZ | DNS | Voicemail | Telephony | Directory Services | Syskemn Events
-4 Operator (3) =
|- Ablantic City LAMN Settings | yoIP || Metwork Topology || SIP Reqistrar
=I5y System (1)
10 3z 128 25
=35 Atlanktic City 1P (3Bl e
#T Line (14) 1P Mask 255 . 255 . 255 . O
4“2 Conkrol Unit (3)
+- 4 Extension (25) Primaty Trans. IP Address 0 ] 0 ]
+-§  User (27)
+ a HuntGroup (1) RIF Mode Mone L
+--@% Short Code (61) [] Enatle AT
B service (D)
o RAS (1) Murnber OF DHCP IP Addresses (200 5
+ ﬁp Incoming Call Route (28) DHER Made

B8 wanPart (0

am Directory (0 ) Server () Client ) Dialin (¥} Disabled

£ Time Profile (0)
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On the VoIP tab in the Details Pane configure the following parameters:

o

System | LAML |LAMZ | DMS || Voicemail | Telephony | Directory Services | System Events | SMTP | SMOR | Twinning | wCM | CCR || Cq

LAM Setkings | ¥oIP | Metwork Topology || SIP Reqistrar

H.323 Gatekeeper Enable
SIP Trunks Enable
SIP Registrar Enable

Check the SIP Trunks Enable box to enable the configuration of SIP trunks.

The RTP Port Number Range can be customized to a specific range of receive ports for
the RTP media. Based on this setting, Avaya IP Office would request RTP media be sent
to a UDP port in the configurable range for calls using LAN1.

Avaya IP Office can also be configured to mark the Differentiated Services Code Point
(DSCP) in the IP Header with specific values to support Quality of Services policies for
both signaling and media. The DSCP field is the value used for media and the SIG
DSCP is the value used for signaling. The specific values used for the compliance test
are shown in the example below and are also the default values. For a customer
installation, if the default values are not sufficient, appropriate values will be provided by
the customer.

Atlantic City £ | % | v |

RTP Part Mumber Range
|:| H.323 Auto-create Exkn

L1

Port Range (Minimum) 43152

H.323 Auto-create User Port R.ange (Maximum) (33246

L1

[] H.323 Remote Extn Enable

Enable RTCP Monitoring
Cn Park 5005

DiffServ Setkings

Fs

B8 3| DSCP(Hex) [FC 3| DSCPMaskiHex) B8 3| 5IG DSCP (Hesx)

46 2| DScP 63 3| DSCPMask 34 |3 sizDscP
DHCP Settings

Primary Site Specific Option Number (S50M) 176 e
Secondary Site Specific Option Murnber (S50M) 242 £
VLAN Mok Present bt

4

1100 Yoice YLAM Site Specific Opkion Number (SS0M) (232

1100 Yoice WLAM IDs
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Scroll down the same page to the RTP keepalives section.

In the RTP Keepalives section, set the Scope to RTP. Set the periodic timeout to 30 and
the Initial Keepalives parameter to Enabled. These settings will cause IP Office to send
a RTP keepalive packet starting at the time of initial connection and every 30 seconds
thereafter if no other RTP traffic is present. This facilitates the flow of media in cases
where each end of the connection is waiting to see media from the other, as well as
helping to keep firewall ports open for the duration of the call.

All other parameters should be set according to customer requirements.

Scope

Initial keepalives

RTP keepalives

RTP % | Periodic timeout 30

Enabled w

On the Network Topology tab in the Details Pane, configure the following parameters:

Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. The Avaya SBCE will perform network address translation of SIP traffic
but it is not necessary for IP Office to have any knowledge of this translation. Thus, the
parameter was set to Open Internet.

Set Binding Refresh Time (seconds) to 30. This value is used to determine the
frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider.

Set the Public Port to the port on which Avaya IP Office will listen.

All other parameters should be set according to customer requirements.

= Atlantic City
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Metwork Topology Discovery

STUM Server IP Address 1 a0 165 13 STUM Part M7
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Binding Refresh Time a0 ~
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Public IP Address ] 0 ] ]
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|:| Fun STUN on skartup
Solution & Interoperability Test Lab Application Notes 12 of 56

©2014 Avaya Inc. All Rights Reserved. AccSiplPO81SBCE



5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony = Telephony tab in the
Details Pane. Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding
and call transfer to the PSTN. If for security reasons incoming calls should not be allowed to
transfer back to the PSTN then leave this setting checked.

E Atlantic City & | X | w]|<]|

System | LANL || L&NZ || DNS Yoicemail | Telephony Directary Services | System Events || SMTP | SMDR | Twinning || YCM CCR Codecs

Telephony | Tones & Music | Call Log

Analoque Extensions Carnpanding Law
Swikch Line
Defaulk Oukside Call Sequence Tarmal w
Default Inside Call Sequence Ring Tvpe 1 w © u-Law © U-Law Line
Defaulk Ring Back Sequence Ring Tvpe 2 w
O A-Law O AO-Law Line

Restrict Analogue Extension Ringer Yoltage [

Dial Delay Time {secs) 4 e [ D=5 status
Dial Delay Count 0 ) Auka Hald
Default Mo Answer Time {secs) 25 e Dial By Mame
Hald Timeauk (secs) ] e Show Account Code
Park Timeout (secs) 300 % [] 1nhibit OFf-Switch Forward Transker
Ring Delay (secs) 5 % [] Restrict Network Interconnect
Call Pricrity Promation Time (secs) |Disabled e [] Drop External cnly Imprompty Conference
Default Currancy LS0 2 [] wisually Differentiate External Call
Default Mame Priority Favor Trunk T [ unsupervised analog Trunk Disconnect Handling
High Quality Conferencding
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 13 of 56

SPOC 2/19/2014 ©2014 Avaya Inc. All Rights Reserved. AccSiplPO81SBCE



5.2.3. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details
Pane as shown in the following screen. The Send original calling party information for
Mobile Twinning box is not checked in the sample configuration, and the Calling party
information for Mobile Twinning is left blank. Click the OK button at the bottom of the page
(not shown).

Atlantic City

Swskermn | LAM1 | LANZ | DMNS Yoicemail | Telephony | Direckory Services || Swstem Events | SMTP | SMDR. | Twinning | 4y

[] send original calling party information For Mabile Twinning

Zalling party information For
Mabile Twinning

5.3. IP Route

Navigate to IP Route = 0.0.0.0 in the left Navigation Pane if a default route already exists.
Otherwise, to create the default route, right-click on IP Route and select New. Create/verify a
default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP Address of the default router to reach Accelerated
Connections.

e Set Destination to LAN1 from the drop-down list.

Click the OK button at the bottom of the page (nhot shown).

IP Offices = 0.000 =R IR AR AR

R BOOTP (4) IF Route
(o Operator (3)
-5 Atlantic City IP Address ] ] ] ]
= System (1) TP Mask 0 0 0 0
4 Line (14)
<2y Control Uit (33 Gateway IP Address 10 32 126 . 254
Al Extension (25)
3 User(zm
#f HurkGroup £1) Metric 0
BX Short Code (613
B service (0) [ Proxy &RP
ol RAS (1)
@ Incoming Call Foute (28)
@ WanPaork (03
#m Directory (0)
£ Time Prafile (o)
@ Fireswall Profile (1)
=il 1P Route (4]
B 0.0.0.0

Destination LANL b

4k
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5.4. SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the
Accelerated Connections SIP Trunking Service. The recommended method for configuring a
SIP Line is to use the template associated with these Application Notes. The template is an .xml
file that can be used by IP Office Manager to create a SIP Line. Follow the steps in Section
5.4.1 to create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.2 — 5.4.5.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation
Pane and select New => SIP Line. Then, follow the steps outlined in Sections 5.4.2 — 5.4.5.
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5.4.1. SIP Line From Template
1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to US_AcceleratedConnections_SIPTrunk.xml. The file name is
important in locating the proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. Inthe IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Verify that the box is checked next to Enable
Template Options. Click OK.

£ 1P Office Manager, Preferences

Preferences || Directories | Discovery | Yisual Preferences | Security || validation

Iron Size | Small w
Multiline Tabs
Enable Template Options

o [ o [ com |[ = |

3. Import the template into IP Office Manager. From IP Office Manager, select Tools -
Import Templates in Manager. This action will copy the template file into the IP
Office template directory and make the template available in the IP Office Manager pull-
down menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

-
™ Avaya IP Office RB.1 Manager Atlantic City [B.1(69)] [A

File  Edit  Miew | Tools | Help

‘9 2 | ::'| Extension Renumber..,
Atlantic City Line Renumber. ..
Conneck To. ..
IP Offi ,
SN Service User Managernenk
K BoOTP (4) L

4 Operator (3) Busy on Held validation

. iC Ci =
&= Atankic City 113 Configuration 1
Sy Syskem (1)
=T+ Line (14}
T:‘. 1 | Import Templates in Manager |
e m

In the pop-up window (not shown) that appears, select the directory where the template
file was copied in Step 1. After the import is complete, a final import status pop-up
window (not shown) will appear stating success or failure. Click OK (not shown) to
continue. If preferred, this step may be skipped if the template file is copied directly to
the IP Office template directory.
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4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane,
then navigate to New - New SIP Trunk From Template.

IP Offices

K BOOTP (4
{7 Operator (3)

Line Zettings |Analogue Options

Analogue Trunk - Line 1

=)=y Atlantic Ci =
= Syster“

=

=)

% [ .
“Zy Conkr
Ay Exten
B-§  User
S8 Hurts
X Short

@ SErvic
s RAS(
@ meom

EE! WanP

anm Direct
£ Time A
i) Firewg

w B B [iE

L. L L

Generate Analogue Trunk Template

Copy Settings From Template

Cuk
Caopy

Delete

Yalidate

Mesw From Template (Binary)

el
Chrl+C

Chrl+Del

H323 Line

IP DECT Line
SIP Line

SIP DECT Line

Mew SIP Trunk From Template

1
Kl P Route (4) -‘ Line Appearance ID
B ficcount Cods (04

5. In the subsequent Template Type Selection pop-up window, select United States from
the Country pull-down menu and select AcceleratedConnections from the Service
Provider pull-down menu as shown below. These values correspond to parts of the file
name (US_AcceleratedConnections_SIPTrunk.xml) created in Step 1. Click Create
new SIP Trunk to finish creating the trunk.

™ Template Type Selection

EEX

Locale

Country Inited States W

Service Provider | AcceleratedConnections s | [] Dizplay &l
[ Create new SIP Trunk, ] [ Cancel ]

During the creation of these Application Notes, the newly created SIP Line did not

appear in the Navigation pane until the SIP Line was updated (in the Details pane) or the
configuration was saved, closed and reopened in IP Office Manager. This is believed to
be a limitation in IP Office 8.1.

6. Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.4.2 — 5.4.5.
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5.4.2. SIP Line — SIP Line Tab
On the SIP Line tab in the Details Pane, configure or verify the parameters as shown below.

e Set ITSP Domain Name to the IP address of the internal signaling interface of the Avaya

SBCE.

e Set Send Caller ID to Diversion Header. With this setting and the related configuration
in Section 5.2.3, IP Office will include the Diversion Header for calls that are directed
via Mobile Twinning out the SIP Line to Accelerated Connections. It will also include
the Diversion Header for calls that are call forwarded out the SIP Line.

e Uncheck REFER Support.

e Check the In Service box. This makes the trunk available to incoming and outgoing

calls.

e Check the Check OOS box. IP Office will use the SIP OPTIONS method to periodically
check the SIP Line. The time between SIP OPTIONS sent by IP Office will use the
Binding Refresh Time for LAN1, as shown in Section 5.2.1.

e Default values may be used for all other parameters.

IP Offices

#- K BOOTR(4)
#-g7 Operator {3)
=) Atlankic City

= SIP Line - Line 21

SIP Line |Transport|SIP URI| YoIP | T38 Fax| SIP Credentials

Line Nurnber z1 5

ek -E X vl<l>

+-52 Swstem (1)
R Line (14) ITSP Domain Mame (10032, 128,20 In Service
+-+2» Contral Unit (3)
+-4fp Extension (25) LSl O
A § User (27 Prefix Check 005
+ -4 HurkGroup (1)
+-@X Short Code (61) Mational Prefix 0 Call Rowting Method Request LRI v
B Service (0) R Criginator number For
Hongly RAS (1) ountry Lode Forwarded and bwinning calls
* @ Incoming Call Routt| | 1overnationsl prefi |00 Marme Priotity System Default v
@ WanPaort {0)
a= Directory (0) Caller 1D from From header [
f.“ Tirne Profile (0) Send From In Clear il
+ @ Firewsall Profile (1) User-Agent and Server
+-Jfll IP Route (4) Headers
@ Account Code (0) Send Caller ID Diversion Header
+ W License (77)
i Tunnel (09 Associakion Method  |By Source IF address
+ ;; Lser Rights (8) [] REFER Support
H - BRI
- R4S Location Requ
- fx E911 System (1)
UPDATE Supported | Mever
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5.4.3. SIP Line - Transport Tab
Select the Transport tab. Set or verify the parameters as shown below.

e Set ITSP Proxy Address to the IP address of the internal signaling interface of the
Avaya SBCE.

e Set Layer 4 Protocol to UDP.

e Set Use Network Topology Info to the network port used by the SIP line to access the
far-end and configured in Section 5.2.1.

e Set the Send Port to 5060.

e Default values may be used for all other parameters.

E SIP Line - Line 21 ek - [ X v ]<]>

SIF Line| Transport [SIP URI|WalP | T38 Fax| SIP Credentials
ITSP Proxy Address  |10.32.128.20
Metwark, Configuration
Layer 4 Protocal 1DP w Send Port (5060 S
Ilse Metwork Topology Info |LAM 1 A
Explicit DNS Server(s) 1] 1] a a a 1] 1] 1]
Calls Route via Registrar
Separate Reqgistrar
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5.4.4. SIP Line - SIP URI Tab

A SIP URI entry must be created to match each incoming number that Avaya IP Office will
accept on this line. Select the SIP URI tab, then click the Add button and the New Channel
area will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at
the top, and click the Edit button. In the example screen below, a new entry is created. The
entry was created with the parameters shown below:

Set Local URI, Contact, and Display Name to Use Internal Data. This setting allows
calls on this line that have a SIP URI that matches the number set in the SIP tab of any
User as shown in Section 5.7.

Set PAI to None. IP Office will not include the PAI header in SIP messaging. Different
PSTN carriers used by Accelerated Connections would use the contents of different SIP
headers to display the calling party number. Removing the use of the PAI header
provided the expected calling party number across the different PSTN carriers
encountered in the compliance test, especially for the call forwarding and twinning
scenarios.

For Registration, select 0: <None> from the pull-down menu.

Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line in Section 5.8.1. Similarly, associate the line to an outgoing line
group using the Outgoing Group field. The outgoing line group number is used in
defining ARS entries for routing outbound traffic to this line in Section 5.6. For the
compliance test, a new incoming and outgoing group 21 was defined that only contained
this line (line 21).

Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

Click OK.
E SIP Line - Line 21 e - X[ vi<]>
SIP Line| Transpart| SIP URD [WoIP | T38 Fax| SIP Credentials
Channel  Groups Wia Local URI | Contact  Display Mame  PAI - Credential  Max Calls Add. ..
Remaove
Edit...
Mew Channel
ia 10.32.128.25
Local URI Use Internal Data -
Contact Use Internal Data w
Display Mame Use Internal Data w
PAL Mone v
Reqistration 0 <Mone> w
Incoming Group 21
Cutgoing Group 21
Max Calls per Channel 10 B
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Additional SIP URIs may be required to allow inbound calls to numbers not associated with a
user, such as a short code. These URIs are created in the same manner as shown above with the
exception that the incoming DID number is entered directly in the Local URI, Contact, and
Display Name fields.

5.45. SIP Line - VoIP Tab

Select the VoI P tab, to set the Voice over Internet Protocol parameters of the SIP line. Set or
verify the parameters as shown below.

e For Codec Selection, select System Default from the pull-down menu to use the default
list of codecs. A list of the codecs in their current order of preference is shown on the
right in the Selected column. To use a custom list of codecs, select Custom for Codec
Selection. Next, move unwanted codecs from the Selected column to the Unused
column. Lastly, move the codecs up or down the list in the Selected column to achieve
the desired order of preference. The example below shows the codecs used for the
compliance test.

Uncheck the VVolIP Silence Suppression box.

Check the Re-invite Supported box.

Set the Fax Transport Support to T.38.

Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

e Default values may be used for all other parameters.

Click the OK button at the bottom of the page (not shown).

= SIP Line - Line 21 o - X[ v <>
SIF Line | Transpork | SIP URI| ¥0IP T35 Fawx || SIP Credentials
Codec Selection Custom w [ vl Silence Suppression
Unused Selected Re-invite Supparted
G, 711 ALANY B4k 3= G, 711 ULAW &4k .
3.723.1 6K3 MP-ML( 3.729(5) 8K C5-ACELP [ use Offerer's Preferred Codec
[] codec Lockdown
e [] PracCK100rel Supported
=
Fax Transport Suppart T38 W
Call Initiation Timeout (s) |4 e
DTMF Suppart RFCZ535 L
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5.5. Short Codes

ARS is used to route outbound traffic to the SIP line. A short code is used to route outbound
traffic to ARS. To create a short code, right-click on Short Code in the Navigation Pane and
select New. On the Short Code tab in the Details Pane, configure the parameters as shown
below.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 9N;. This short code will be invoked when the user dials 9
followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N. The value N represents the number dialed by the user after
removing the 9 prefix. This value is passed to ARS.

e Setthe Line Group Id to the ARS route to be used which is defined in Section 5.6.

Click the OK button (not shown).

IP Offices B 9N;: Dial |
K BOOTR (4) Short Code
1% Operator (3)
(== Atlantic City Code an;

3y System (1)

7 Line (14) Feature Dial A
< Control Unit (3 Telephone Mumber [N

Ay Extension (25)

a User (277 Line Group ID 51: 3P 5IP Route w

W HuntGroup (1)

L Hdshort Code (61)
B Service (0) Force Account Code [

ol RAS (1)

Locale
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Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N;
short code except that the Telephone Number field begins with the letter W, which means
“withhold the outgoing calling line identification”. In the case of the SIP Line to Accelerated
Connections documented in these Application Notes, when a user dials *67 plus the number, IP
Office will include the user’s telephone number in the P-Preferred-Identity (PPI) header and will
include the Privacy: Id header. Accelerated Connections will allow the call due to the presence
of a valid DID in the PPI header, but will prevent presentation of the caller id to the called PSTN
destination.

B *67N;: Dial |
Shott Code
Code *a 7,
Feature Dial “

Telephone Mumber — [WH
Lime Group ID 51! 5P 5IP Route v

Locale W

Force account Code [
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5.6. ARS

ARS is used to route outbound traffic to the SIP line. To define a new ARS route, right-click
ARS in the Navigation pane and select New. In the Details pane that appears, a collection of
matching patterns (similar to short codes) can be entered to route calls as shown below.

For the compliance test, two entries were created. The first entry matches on any 1 + 10 digit
number (LXXXXXXXXXX) and then sends only 10 digits (N) in the SIP INVITE message on
the line group defined in Section 5.4.4 (e.g., line group 21). The second entry matches on any
other number (N) and passes it unaltered to the line group.

To create an entry, click the Add button and enter the following in the pop-up window (not
shown).

e Inthe Code field, enter the pattern to match the number passed to ARS from the short
code in Section 5.5 followed by a semi-colon.

e Set Feature to Dial. This is the action that the entry will perform.

e Set Telephone Number to N”@10.32.128.20”. This field is used to construct the
Request URI and To headers in the outgoing SIP INVITE message. In the first entry, N
represents the remaining 10 digits after removing the preceding 1. In the second entry,
the value N represents the complete number passed to ARS. The IP address 10.32.128.20
is the IP address of the private side of the Avaya SBCE.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.4.4. This short code will use this line group when placing the
outbound call.

Click the OK button (not shown).

IP Offices B SP SIP Route e M X[ v <]

#- R BOOTP (4) ARS
+-¢# Operator (3)
=I5 Atlantic City ARS Route Id [ secondary Dial tone
H-%59 System (1)
-9 Line {14) Foute Marme 5P SIP Routs
#-<=» Control Unit {3}
#- o Extension (25) Dial Delay Time System Defaulk (4) ] check User Call Barring
£ ‘ User (273
£ ﬂ HuntGroup (1)
+- @ Short Code (62)
@ Service (0)
il RAS (1) l
+ @ Incoming Call Route (283
8 wanPart (0) Time Profile ey Ok of Hours Routke <MNones v

In Service Qut of Service Route <Mone> w

a4 Directory {0)
f’.“ Time Profile {00 l

+ @ Firewall Profile (1)
=l TP Route (4) Code Telephone Murnber Feature Line Group 1D
| Account Code {00 TRERRRRRRNR, N'@10,32.128.20" Dial 21
4% License (77) I; N'@10,32.128.20" Dial 21
% Tunnel (0) S
+-fig User Rights (8)
- BRS(Z)
" 50: Main
W51 SP SIP Rouke
# RAS Location Request (0}

Remave
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.4. To configure these settings, first navigate to User = Name in the
Navigation Pane where Name is the name of the user to be modified. In the example below, the
name of the user is Extn243. Select the SIP tab in the Details Pane. The values entered for the
SIP Name and Contact fields are used as the user part of the SIP URI in the From and Contact
headers for outgoing SIP trunk calls and allow matching of the SIP URI for incoming calls
without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4.4). The
example below shows the settings for user Extn243. The SIP Name and Contact are set to one
of the DID numbers assigned to the enterprise from Accelerated Connections. The SIP Display
Name (Alias) parameter can optionally be configured with a descriptive name. If all calls
involving this user and a SIP Line should be considered private, then the Anonymous box may
be checked to withhold the user’s information from the network.

Click the OK button (not shown).

IP Offices x

- R BOOTP {4)
#- g7 Operabor (3)

User | Woicemail | DND || ShortCodes | Source Mumbers || Telephony | Forwarding | Dial In | Woice Recarding || |

; = . ; SIP
Z). 5 Atlartic City Menu Programming || Mability | Phone Manager Options | Hunt Group Membership | Announcements Pers
+-s55y System (1) SIF Mame 4165551236
+-T9 Line (14)
+-2r Conkrol Unit {3} SIP Display Mame (Alias) |Extnz43
+--4y Extension (23)
o Llser (27 Caontack 4165551236

+ ﬂ Huntroup(l)
+- @ Short Code (613

Ananymous
@ Service (0) O ¥
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5.8. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To
create an incoming call route, right-click Incoming Call Routes in the Navigation Pane and

select New.

5.8.1. Incoming Call Route — Standard Tab
On the Standard tab of the Details Pane, enter the parameters as shown below.

e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section

5.4.4.

e Set the Incoming Number to the incoming number on which this route should match.
e Default values can be used for all other fields.

IP Offices :

K BOOTP (4)
{7 Operatar (3)
[=-*52p Atlankic City
w2y Swskem (1)
4 Line (14)
<2 Control Unik (3)
Al Extension (25)
g User (27)
-ﬂ HuntGroup 1)
@ Short Code (61)
@ Service (0}
ol RAS (1)

EE! WanPort (0)

wm Directory (00

‘T‘ Time Profile {00
@ Firewsall Profile {1}
B IF Route (4)

| Account Code (0)

@ Incoming Call Route (27

Standard | yoice Recording | Destinations

Bearer Capability Any Yoice w
Line Group [0 21 L
Incoming Murmber 4165551236

Incoming Sub Address

Incoming CLI

Locale A
Priority 1 - Low b
Tag

Hald Music Source Systern Source b

5.8.2. Incoming Call Route — Destinations Tab

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. Click the OK button (not shown). In this example, incoming calls to
4165551236 on line 21 are routed to extension 243.

Standard | Yaice Recording | Destinations

21 4165551236 B - X w <>

TimePrafile Deskination Fallback Extension
2 Default Walue 243 ExtnZ43 w w
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Incoming Call Routes for other direct mappings of DID numbers to IP Office users listed in

Figure 1 are omitted here, but can be configured in the same fashion.

5.9. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service
disruption. Click OK to proceed.
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Save Configuration

IP Ciffice Settings
Atlantic Ciky
Configuration Reboaot Mode
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) Immediate
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6. Configure Avaya Session Border Controller for Enterprise

This section describes the configuration of the Avaya SBCE. It is assumed that the initial
installation of the Avaya SBCE has been completed including the assignment of a management
IP address. The management interface must be provisioned on a different subnet than either the
Avaya SBCE private or public network interfaces (e.g., Al and B1). If the management
interface has not been configured on a separate subnet, then contact your Avaya representative
for guidance in correcting the configuration.

On all screens described in this section, it is to be assumed that parameters are left at their default
values unless specified otherwise.

6.1. Access the Management Interface

Use a web browser to access the web interface by entering the URL https://<ip-addr>, where
<ip-addr> is the management IP address assigned during installation. The Avaya SBCE login
page will appear as shown below. Log in with appropriate credentials.

AVAYA =

Password:

SeSSion BD rder Co ntrol Ier Thiz system iz restricted =olely to authorized users for legitimate
= businesz purpozes only. The actual or attempted unauthorized access,
for Enterp rlse uze or modificationz of thiz system iz strictly prohibited. Unauthorized

uzers are =ubject to company dizciplinary procedurez and or criminal
and civil penalties under state, federal or other applicable domestic and
foreign laws.

The uze of thiz =system may be monitored and recorded for
administrative and security reasons. Anyene accessing this system
exprezsly consents to zuch monitoring and recording, and is advized
that if it reveals possible evidence of criminal activity, the evidence of
zuch activity may be provided to law enforcement officials.

All usgers must comply with all corporate instructions regarding the
protection of information assets.

@ 2011 - 2013 Avaya Inc. All rights reserved.
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After logging in, the Dashboard screen will appear as shown below. All configuration screens of
the Avaya SBCE are accessed by navigating the menu tree in the left pane.

Alarms  Incidents  Statistics  Logs  Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Dashboard

Administration
Backup/Restore System Time 02:41-:48 PM EDT Refresh EMS

System Management

> Global Parameters e AZDLEE wnj-shce2

> Global Profiles Build Date Thu Feb 14 23:25:50 UTC 2013

> SIP Cluster

. Domain Policies
MNone found. Mone found.

TLS Management

Device Specific Settings o

Mo notes found.
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6.2. Verify Network Configuration and Enable Interfaces

To view the network information provided during installation, navigate to System Management.
In the right pane, click View highlighted below.

>

3

3

B

3

>

Dashboard
Administration
Backup/Restore
System Management

Global Parameters
Global Profiles
SIP Cluster
Domain Palicies
TLS Management

Device Specific Settings

Session Border Controller for Enterprise AVAYA

System Management

Devices | | Updates || 5SL VPN | | Licensing

Device Mame  Management

Version Status

(Serial Number)

‘(‘;g;??;zme& 10.32.101.20 6.2.0.Q36 Commissioned Reboot  Shutdown Restartﬁ«.pp\icat\anclit Delete

A System Information page will appear showing the information provided during installation. In
the Appliance Name field is the name of the device (vnj-sbce2). This name will be referenced
in other configuration screens. Interfaces Al and B1 represent the private and public interfaces
of the Avaya SBCE. Each of these interfaces must be enabled after installation.

System Information: vnjsbce2 X

Appliance Mame
Box Type

Deployment Mode

r General Configuration Device Configuration
vnj-shce? HA Made Mo
SIP Two Bypass Mode Mo
Proxy

10.32.128.20

192.168.96.233

r Network Configuration

Public IP Metmask Gateway Interface
10.32.128.20 2585 255 2650 10.32.128.254 Al
192.168.96.233 255 255 255 224 192.168.96.254 B1

r DNS Configuration Management IP(s)
Primary DNS 10.32.128.200 IP 10.32.101.20
Secondary DNS
DMS Location DMZ
DMS Client IP 10.32.128.20
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To enable the interfaces, first navigate to Device Specific Settings = Network Management in
the left pane and select the device being managed in the center pane. In the right pane, click on
the Interface Configuration tab. Verify the Administrative Status is Enabled for both the Al
and B1 interfaces. If not, click Toggle to enable the interface.

Dashboard

Administration

~

Session Border Controller for Enterprise AVAYA

Network Management: vnj-sbce2

Backup/Restore i 1
Network Configuration | | Interface Configuration |
System Management : 1
> Global Parameters vnj-sbee? Administrative Status
> Global Profiles Al Enabled Toggle
» SIP Cluster A2 Disabled Toggle
> Domain Policies
B1 Enabled Toggle
> TLS Management
4 Device Specific Settings
Network
Management
Media Interface
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6.3. Signaling Interface

A signaling interface defines an IP address, protocols and listen ports that the Avaya SBCE can
use for signaling. Create a signaling interface for both the internal and external sides of the
Avaya SBCE.

To create a new interface, navigate to Device Specific Settings = Signaling Interface in the
left pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be managed. In the
right pane, select Add. A pop-up window (not shown) will appear requesting the name of the
new interface, followed by series of pop-up windows in which the interface parameters can be
configured. Once complete, the settings are shown in the far right pane.

For the compliance test, signaling interface Int_Sig_Intf was created for the Avaya SBCE
internal interface and signaling interface Ext_Sig_Intf was created for the Avaya SBCE external
interface. Each is highlighted below. When configuring the interfaces, configure the parameters
as follows:

e Set Name to a descriptive name.

e For the internal interface, set the Signaling IP to the IP address associated with the private
interface (Al) defined in Section 6.2. For the external interface, set the Signaling IP to the
IP address associated with the public interface (B1) defined in Section 6.2.

e In the UDP Port, TCP Port and TLS Port fields, enter the port the Avaya SBCE will listen
on for each transport protocol. For the internal interface, the Avaya SBCE was configured
to listen for UDP on port 5060. For the external interface, the Avaya SBCE was configured
to listen for UDP or TCP on port 5060. Since Accelerated Connections uses UDP on port
5060, it would have been sufficient to simply configure the Avaya SBCE for UDP.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Interface: vnj-sbce2
Administration
Backup/Restore ' —‘
System Management Signaling Interface
> Global Parameters vnj-sbee2 Add
» Global Profiles
Signaling IP TLS Profile
> SIP Cluster
> Domain Policies Int_Sig_Intf 10.32.1258.20 5060 — MNone Edit Delete
> TLS Management Ext_Sig_Intf 102.168.06.233 5060 5060 —  Mone Edit Delete

4 Device Specific Settings

Network Management
Media Interface
Signaling Interface
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6.4. Media Interface

A media interface defines an IP address and port range for transmitting media. Create a media
interface for both the internal and external sides of the Avaya SBCE.

To create a new interface, navigate to Device Specific Settings = Media Interface in the left
pane. In the center pane, select the Avaya SBCE device (vnj-sbce2) to be managed. In the right
pane, select Add. A pop-up window (not shown) will appear requesting the name of the new
interface, followed by series of pop-up windows in which the interface parameters can be
configured. Once complete, the settings are shown in the far right pane.

For the compliance test, media interface Int_Media_Intf was created for the Avaya SBCE
internal interface and media interface Ext_Media_Intf was created for the Avaya SBCE external
interface. Each is highlighted below. When configuring the interfaces, configure the parameters
as follows:

e Set Name to a descriptive name.

e For the internal interface, set the Media IP to the IP address associated with the private
interface (A1) defined in Section 6.2. For the external interface, set the Media IP to the IP
address associated with the public interface (B1) defined in Section 6.2.

e Set Port Range to a range of ports acceptable to both the Avaya SBCE and the far-end. For
the compliance test, the default port range was used for both interfaces.

Session Border Controller for Enterprise AVAYA
Dashboard Media Interface: vnj-sbhce2
Administration
Backup/Restore
Media Interface

System Management
. Global P t vnj-sbce2

obal Farameters Modifying or deleting an existing media interface will require an application restart before taking
> (Global Profiles effect. Application restars can be issued from Systern Management.

> SIP Cluster

> Domain Paolicies

. TLS Management Name Media IP Port Range
+ Device Specific Settings Int_Media_Intf 10.32.128.20 35000 - 40000 Edit Delete
Network Management Ext_Media_lntf 192.168.96.233 35000 - 40000 Edit Delete
Media Interface
Signaling Interface
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6.5. Server Interworking

A server interworking profile defines a set of parameters that aid in interworking between the
Avaya SBCE and a connected server. Create a server interworking profile for Avaya IP Office
and the service provider SIP server. These profiles will be applied to the appropriate server in
Section 6.7.1 and 6.7.2.

To create a new profile, navigate to Global Profiles = Server Interworking in the left pane. In
the center pane, select Add. A pop-up window (not shown) will appear requesting the name of
the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane. Alternatively, a new
profile may be created by selecting an existing profile in the center pane and clicking the Clone
button in the right pane. This will create a copy of the selected profile which can then be edited
as needed. To view the settings of an existing profile, select the profile from the center pane.
The settings will appear in the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard ~|  Interworking Profiles: ¢s2100
Administration dd
Backup/Restore
Interworking i i i i i

System Management It is not recommended to edit the defaults. Try cloning or adding a new profile instead.
> Global Parameters 2100 General || Timers H URI Manipulation H Header Manipulati || Ad ed |

Dﬂmain DOS avaya-ru i:l'\i':fﬂ

Fingerprint 0CS-Edge-Ser... Hold Support RFC3264

Server cisco-cem 180 Handling MNone

Interworking cupe 181 Handling Nane

Phone Interworking 182 Handling None

Media Forking OCS-FrontEnd.. .

Routing 183 Handling Mone

Server Gonfiguration a3 Refer Handling No L
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6.5.1. Server Interworking — Avaya IP Office

For the compliance test, server interworking profile IPOffice-T38 was created for Avaya IP
Office by creating a new profile and accepting the default values for all settings with the
exception of setting the T.38 Support to Yes. The General tab parameters are shown below.

General | ‘ Timers | ‘ URI Manipulation ‘ | Header Manipulation ‘ | Advanced |

General

s

Privacy Enabled
User Name
P-Asserted-ldentity
P-Preferred-ldentity

Privacy Header

DTMF Support

Hold Support MOME
180 Handling Mone
181 Handling Mone
182 Handling MNone
183 Handling Mone
Refer Handling Mo
3:xx Handling Mo
Diversion Header Support MNo
Delayed SOP Handling Mo
T.38 Support Yes
URI Scheme SIP
Wia Header Format RFC3261

DTMF

Mone

Edit

<

The Timers, URI Manipulation, Header Manipulation tabs have no entries.
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The Advanced tab parameters are shown below.

General ‘ ‘ Timers ‘ ‘ URI Manipulation ‘ ‘ Header Manipulation Advanced

Record Routes Both
Topology Hiding: Change Call-D Yes
Call-Info NAT Mo

Change Max Forwards Yes

Include End Point IP for Context Lookup Mo

0OCS Extensions Mo
AVAYA Extensions Mo
MNORTEL Extensions Mo
Diversion Manipulation Mo
Metaswitch Extensions Mo
Reset on Talk Spurt Mo

Reset SRTP Context on Session Refresh  No

Has Remote SBC Yes
Route Response on Via Port Mo
Cisco Extensions Mo

6.5.2. Server Interworking — Accelerated Connections

For the compliance test, server interworking profile SP-General-T38 was created for the
Accelerated Connections SIP server. When creating the profile, the default values were used for
all parameters with the exception of T.38 Support set to Yes. Thus, the SP-General-T38
profile is identical to the IPOffice-T38 profile created in Section 6.5.1.

6.6. Signaling Manipulation

Signaling manipulation scripts provides for the manipulation of SIP messages which cannot be
done by other configuration within the Avaya SBCE. It was not necessary to create any
signaling manipulation scripts for interoperability with Accelerated Connections.
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6.7. Server Configuration

A server configuration profile defines the attributes of the physical server. Create a server
configuration profile for Avaya IP Office and the service provider SIP server.

To create a new profile, navigate to Global Profiles = Server Configuration in the left pane.
In the center pane, select Add. A pop-up window (not shown) will appear requesting the name
of the new profile, followed by series of pop-up windows in which the profile parameters can be
configured. Once complete, the settings are shown in the far right pane. To view the settings of
an existing profile, select the profile from the center pane. The settings will appear in the right
pane.

Session Border Controller for Enterprise AVAYA

Dashboard Server Configuration

Administration Add

Backup/Restore

Server Profiles -
System Management ! Use the add button to create a new Server Configuration profile.
> Global Parameters Mo entries

found.

4 (Global Profiles

Domain DoS

Fingerprint

Server Interworking

Phone Interworking

Media Forking

Routing

Topology Hiding
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6.7.1. Server Configuration — Avaya IP Office

For the compliance test, server configuration profile IPO-ACity was created for Avaya IP
Office. When creating the profile, configure the General tab parameters as follows:

e Set Server Type to Call Server.

e Set IP Addresses / FQDNSs to the IP address of the Avaya IP Office signaling interface.

e Set Supported Transports to the transport protocol used for SIP signaling between Avaya
IP Office and the Avaya SBCE.

e Set the UDP Port to the port Avaya IP Office will listen on for SIP requests from the Avaya

SBCE.

[ Rename ][ Clone ][ Delete l

General | | Authentication

Heartbeat | | Advanced

Server Type
IP Addresses / FQDMs
Supported Transports

LIDP Port

Call Server
10.32.128.25
LUDP

5060

On the Advanced tab, set the Interworking Profile field to the interworking profile for Avaya
IP Office defined in Section 6.5.1.

[ Rename ][ Clone ][ Delete ]
General | | Authentication | | Heartbeat | | Advanced
Enable DoS Protection L
Enable Grooming F
Interworking Profile IPOffice-T38
Signaling Manipulation Script Mone
LIDP Connection Type SUBID
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6.7.2. Server Configuration — Accelerated Connections

For the compliance test, server configuration profile Accelerated was created for Accelerated
Connections. When creating the profile, configure the General tab parameters as follows:

e Set Server Type to Trunk Server.

e Set IP Addresses / FQDNSs to the IP address of the Accelerated Connections SIP server.

e Set Supported Transports to the transport protocol used for SIP signaling between
Accelerated Connections and the Avaya SBCE. In the compliance test, UDP was used.

e Set the UDP Port to the standard SIP port of 5060. This is the port Accelerated
Connections will listen on for SIP requests from the Avaya SBCE.

General ‘ | Authentication | | Heartheat | ‘ Advanced |

[ Rename ” Clone ” Delete ]

Senver Type
IP Addresses / FODMs
Supported Transports

LIDP Paort

Trunk Server
192.168.185.110
UDP

5060

On the Advanced tab, set the Interworking Profile field to the interworking profile for
Accelerated Connections defined in Section 6.5.2.

General ‘ ‘ Authentication || Heartbeat ‘ ‘ Advanced |

[ Rename ][ Clone H Delete ]

Enable DoS Protection
Enable Grooming

Interworking Profile

O
O

SP-General-T38

Signaling Manipulation Script MNone
UDP Connection Type SUBID
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6.8. Application Rules

An application rule defines the allowable SIP applications and associated parameters. An
application rule is one component of the larger endpoint policy group defined in Section 6.11.
For the compliance test, the predefined default-trunk application rule (shown below) was used
for both Avaya IP Office and the Accelerated Connections SIP server.

To view an existing rule, navigate to Domain Policies = Application Rules in the left pane. In
the center pane, select the rule (e.g., default-trunk) to be viewed.

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> SIP Cluster

4 Domain Palicies
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules
Time of Day Rules
End Point Policy

Session Border Controller for Enterprise AVAYA

Application Rules: default-trunk

Add

Application
Rules
default

default-trunk

|Fi\terBy Device... V|

Maximum Concurrent  Maximum Sessions

oL Sessions Per Endpoint
Voice 2000 2000
Video [T
M [

Miscellaneous

CDR Support Mone

RTCF Keep-Alive Mo
Groups
Session Policies
> TLS Management
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6.9. Media Rules

A media rule defines the processing to be applied to the selected media. A media rule is one
component of the larger endpoint policy group defined in Section 6.11. For the compliance test,
the predefined default-low-med media rule (shown below) was used for both Avaya IP Office
and the Accelerated Connections SIP server.

To view an existing rule, navigate to Domain Policies = Media Rules in the left pane. In the
center pane, select the rule (e.g., default-low-med) to be viewed.

Each of the tabs of the default-low-med media rule containing data is shown below.

The Media NAT tab has no entries.

Session Border Controller for Enterprise AVAYA
Dashboard Media Rules: default-low-med

Administration |Filter By Davice... v
Backup/Restore

Media Rules It is not recommended to edit the defaults. Try cloning or adding a new rule instead.

System Management

default-low-med
> Global Parameters Media NAT ‘ | Media Encryption ‘ | Media Anomaly | | Media Silencing ‘ | Media QoS |
» Global Profiles default-low-med-enc
- SIP Cluster default-high Media NAT Learn Media IP dynamically
4 Domain Policies
i default-high-enc
Application Rules

Border Rules avaya-low-med-enc

The Media Encryption tab indicates that no encryption was used.

Media NAT | | Media Encryption | Media Anomaly | | Media Silencing | | Media QoS |

Audio Encryption
Preferred Formats RTP

Interworking

Preferred Formats RTP

Interworking

Capahility Megotiation O
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The Media Anomaly tab shows Media Anomaly Detection was enabled.

Media NAT | | Media Encryption | | HMedia Anomaly || Media Silencing | | Media QoS |

Media Anomaly Detection

Detect RTP Injection Attack
Asymmetric RTP O
Action Alert

The Media Silencing tab has no entries.

The Media QoS settings are shown below.

Media MAT | | WMedia Encryption | | Media Anomaly | | Media Silencing Media Qo5

Media QoS Reporting

RTCP Enabled Ll

Media QoS Marking

Enabled
QoS Type DSCP
Audio Qo5
Audio DSCP EF
Video QoS
Video DSCP EF

42 of 56
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6.10. Signaling Rules

A signaling rule defines the processing to be applied to the selected signaling traffic. A signaling
rule is one component of the larger endpoint policy group defined in Section 6.11. For the
compliance test, the predefined default signaling rule (shown below) was used for both Avaya
IP Office and the Accelerated Connections SIP server.

To view an existing rule, navigate to Domain Policies = Signaling Rules in the left pane. In
the center pane, select the rule (e.g., default) to be viewed.

The General tab settings are shown below.

Session Border Controller for Enterprise AVAYA
Dashbeard Signaling Rules: default
Administration [Filter By Device... v
Backup/Restore
Signaling Rules It is not recommended to edit the defaults. Try cloning or adding a new rule instead.
System Management
default
> Global Parameters General | Requests H Responses || Request Head || Resp Head || Signaling QoS ‘
> Global Profiles No-Content-Typ... ~
> SIP Cluster
R it All
4 Domain Policies Fuests o
Application Rules Non-2XX Final Responses Allow
Border Rules Optional Request Headers Allow
Media Rules Optional Response Headers Allow
Security Rules
Time of Day Rules Requests Allow
End Point Policy Non-2XX Final Responses Allow
Groups
Session Palicies Optional Request Headers Allow
> TLS Management Optional Response Headers Allow
> Device Specific Settings
Content-Type Policy
Enable Content-Type Checks )
Action Allow Multipart Action Allow
w

The Requests, Responses, Request Headers, and Response Headers tabs have no entries. The
Signaling QoS tab is shown below.

General ‘ | Requests ‘ | Responses || Request Headers ‘ | Response Headers Signaling QoS
Signaling QoS
QoS Type DSCP
DSCP AF41
CTM; Reviewed: Solution & Interoperability Test Lab Application Notes 43 of 56

SPOC 2/19/2014 ©2014 Avaya Inc. All Rights Reserved. AccSiplPO81SBCE



6.11. Endpoint Policy Groups

An endpoint policy group is a set of policies that will be applied to traffic between the Avaya
SBCE and a signaling endpoint (connected server). Thus, an endpoint policy group must be
created for Avaya IP Office and the service provider SIP server. The endpoint policy group is
applied to the traffic as part of the endpoint flow defined in Section 6.14.

To create a new group, navigate to Domain Policies = End Point Policy Groups in the left
pane. In the center pane, select Add. A pop-up window (not shown) will appear requesting the
name of the new group, followed by series of pop-up windows in which the group parameters
can be configured. Once complete, the settings are shown in the far right pane. To view the
settings of an existing group, select the group from the center pane. The settings will appear in
the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Policy Groups: default-low
Administration Add \ Filter By Device.. v ‘
Backup/Restore
Policy G 5 iz e ende: adit the de S. & instead.
System Management It is not recommended to edit the defaults. Try adding a new group instead
default-low
> Global Profiles default-low-enc
Policy Group
> SIP Cluster default-med
<« Domain Policies -S -Add
default-med-enc —
Application Rules ) Order  Application  Border Media Security  Signaling  Time of Day
Border Rules GRS defaultlow
-I default default 0 default-low  default default Edit  Clone
Media Rules default-high-enc -med
Security Rules

QCS-default-high
Signaling Rules

. -def-low-e...
Time of Day Rules avaya-cerione

End Point Policy
Groups

6.11.1. Endpoint Policy Group — Avaya IP Office

For the compliance test, endpoint policy group IPO-EP-Policy was created for Avaya IP Office.
Default values were used for each of the rules which comprise the group with the exception of
Application. For Application, enter the application rule created in Section 6.8. The details of
the default settings for Media and Signaling are showed in Section 6.9 and Section 6.10
respectively.

Policy Group

Summary ][ Add ]

Order  Application Border Media Security Signaling  Time of Day

default- default-low . e
trunk default -med default-low  default default Edit Clane
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6.11.2. Endpoint Policy Group — Accelerated Connections

For the compliance test, endpoint policy group SP-EP-Policy was created for the Accelerated
Connections SIP server. Default values were used for each of the rules which comprise the
group with the exception of Application. For Application, enter the application rule created in
Section 6.8. Thus, the SP-EP-Policy is identical to the IPO-EP-Policy created in Section
6.11.1.

6.12. Routing

A routing profile defines where traffic will be directed based on the contents of the URI. A
routing profile is applied only after the traffic has matched an endpoint server flow defined in
Section 6.14. Create a routing profile for Avaya IP Office and the service provider SIP server.

To create a new profile, navigate to Global Profiles = Routing in the left pane. In the center
pane, select Add. A pop-up window (not shown) will appear requesting the name of the new
profile, followed by series of pop-up windows in which the profile parameters can be configured.
Once complete, the settings are shown in the far right pane. To view the settings of an existing
profile, select the profile from the center pane. The settings will appear in the right pane.

Session Border Controller for Enterprise AVAYA
Dashboard Routing Profiles: default
Administration Add
Backup/Restore
System Management It is not recommended to edit the defaults. Try cloning or adding a new profile instead.
> Global Parameters default Routing Profile
4 Global Profiles
Domain DoS
Fingerprint Priority URI Group Mext Hop Server 1 Mext Hop Server 2
Server Interworking 1 ) View  Edi

Phone Interworking
Media Forking

Server Configuration
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6.12.1. Routing — Avaya IP Office

For the compliance test, routing profile To-1PO-ACity was created for Avaya IP Office. When
creating the profile, configure the parameters as follows:

e Set the URI Group to the wild card * to match on any URI.

e Set the Next Hop Server 1 field to the IP address of Avaya IP Office signaling interface.
e Enable Next Hop Priority.

e Set the Outgoing Transport field to UDP.

View Routing Rule X

Priority 1
LRI Group *
Mext Hop Server 1 10.32.128.25

Mext Hop Server 2

Mext Hop Priarity
MNAPTR i
SRV O
Mext Hop in Dialog Fi
lgnore Route Header ]
Qutgoing Transport LDP
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6.12.2. Routing — Accelerated Connections

For the compliance test, routing profile To-SP was created for Accelerated Connections. When
creating the profile, configure the parameters as follows:

e Set the URI Group to the wild card * to match on any URI.

e Set the Next Hop Server 1 field to the IP address of the Accelerated Connections SIP
server.

e Enable Next Hop Priority.
e Set the Outgoing Transport field to UDP as defined by Accelerated Connections.

View Routing Rule X

Priority 1
URI Group *
Mext Hop Server 1 192.168.185.110

MNext Hop Server 2

Mext Hop Priority
NAPTR Fi
SRV O
Mext Hop in Dialog ]
Ignore Route Header F
Outgoing Transport UDP
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6.13. Topology Hiding

Topology hiding allows the host part of some SIP message headers to be modified in order to
prevent private network information from being propagated to the untrusted public network. It
can also be used as an interoperability tool to adapt the host portion of these same headers to
meet the requirements of the connected servers. The topology hiding profile is applied as part of
the endpoint flow in Section 6.14. For the compliance test, the predefined default topology
hiding profile (shown below) was used for both Avaya IP Office and the Accelerated
Connections SIP server.

To add a new profile or view an existing profile, navigate to Global Profiles & Topology
Hiding in the left pane. In the center pane, select Add to add a new profile. In the center pane,
select an existing profile (e.g., default) to be viewed.

Session Border Controller for Enterprise AVAYA
Dashboard Topology Hiding Profiles: default
Administration Add

Backup/Restore
System Management p ;:’:igles g It is not recommended to edit the defaults. Try cloning or adding a new profile instead.

> Global Parameters default Topology Hiding
4 (Global Profiles Hoad — o Val
i eade Criteri eplace Actiol enwrite e
Dormain DoS cisco_th_profile ader riteria place Action verwrite Valu
. . SDP IP/Domain Auto
Fingerprint
Server Interworking From IP/Domain Auto
Phone Interworking Request-Line IP/Domain Auto
Media Forking To IP/Domain Auto
Routing Record-Route IP/Domain Auto
Server Configuration
) ; .
Topology Hiding Via IP/Domain Auto
Signaling Manipulation
URI Groups
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6.14. End Point Flows

Endpoint flows are used to determine the signaling endpoints involved in a call in order to apply
the appropriate policies. When a packet arrives at the Avaya SBCE, the content of the packet (IP
addresses, URIs, etc) is used to determine which flow it matches. Once the flow is determined,
the flow points to policies and profiles which control processing, privileges, authentication,
routing, etc. Once routing is applied and the destination endpoint is determined, the policies for
the destination endpoint are applied. Thus, two flows are involved in every call: the source
endpoint flow and the destination endpoint flow. In the case of the compliance test, the signaling
endpoints are Avaya IP Office and the service provider SIP server.

To create a new flow for a server endpoint, navigate to Device Specific Settings = End Point
Flows in the left pane. In the center pane, select the Avaya SBCE device (vnj-shce2) to be
managed. In the right pane, select the Server Flows tab and click the Add button. A pop-up
window (not shown) will appear requesting the name of the new flow and the flow parameters.
Once complete, the settings are shown in the far right pane.

Session Border Controller for Enterprise AVAYA
Dashboard End Point Flows: vnj-sbce2

Administration

Backup/Restore

Subscriber Flows | Server Flows

vnj-shce2 Add

System Management

> Global Parameters

> Global Profiles
. SIP Cluster Use the add button to create a new Server Flow.

> Domain Policies

> TLS Management

4 Device Specific Settings
Metwork Management
Media Interface
Signaling Interface
Signaling Forking
End Point Flows

Session Flows
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6.14.1. End Point Flow — Avaya IP Office

For the compliance test, endpoint flow IPO-ACity was created for Avaya IP Office. All traffic
from Avaya IP Office will match this flow as the source flow and use the specified Routing
Profile To-Trunks to determine the destination server and corresponding destination flow. The
End Point Policy and Topology Hiding Profile will be applied as appropriate. When creating
the flow, configure the parameters as follows:

For the Flow Name, enter a descriptive name.

For Server Configuration, select the Avaya IP Office server created in Section 6.7.1.
To match all traffic, set the URI Group, Transport, and Remote Subnet to *.

Set the Received Interface to the external signaling interface.

Set the Signaling Interface to the internal signaling interface.

Set the Media Interface to the internal media interface.

Set the End Point Policy Group to the endpoint policy group defined for Avaya IP
Office in Section 6.11.1.

Set the Routing Profile to the routing profile defined in Section 6.12.2 used to direct
traffic to the Accelerated Connections SIP server.

Set the Topology Hiding Profile to the topology hiding profile defined for Avaya IP
Office in Section 6.13.

View Flow: IPO-ACity X

r Criteria r Profile
Flow Mame [PO-ACity Signaling Interface Int_Sig_Intf
Server Configuration  [PO-ACity Media Interface Int_Media_Intf
URI Group * End Point Policy Group  IPO-EP-Paolicy
Transport * Routing Profile To-SP
Remote Subnet * Topology Hiding Profile  default
Received Interface Ext Sig Intf File Transfer Profile MNone
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6.14.2. End Point Flow — Accelerated Connections

For the compliance test, endpoint flow Accelerated was created for the Accelerated Connections
SIP server. All traffic from Accelerated Connections will match this flow as the source flow and
use the specified Routing Profile To-IPO-ACity to determine the destination server and
corresponding destination flow. The End Point Policy and Topology Hiding Profile will be
applied as appropriate. When creating the flow, configure the parameters as follows:

e For the Flow Name, enter a descriptive name.

e For Server Configuration, select the Accelerated Connections SIP server created in

Section 6.7.2.

To match all traffic, set the URI Group, Transport, and Remote Subnet to *.

Set the Received Interface to the internal signaling interface.

Set the Signaling Interface to the external signaling interface.

Set the Media Interface to the external media interface.

Set the End Point Policy Group to the endpoint policy group defined for Accelerated

Connections in Section 6.11.2.

e Set the Routing Profile to the routing profile defined in Section 6.12.1 used to direct
traffic to Avaya IP Office.

e Set the Topology Hiding Profile to the topology hiding profile defined for Accelerated
Connections in Section 6.13.

View Flow: Accelerated X

r Criteria r Profile
Flow Mame Accelerated Signaling Interface Ext_Sig_Intf
Server Configuration  Accelerated Media Interface Ext_Media_Intf
URI Group * End Point Policy Group  SP-EP-Palicy
Transport * Routing Profile To-IPO-ACity
Remote Subnet * Topology Hiding Profile  default
Received Interface Int_Sig_Intf File Transfer Profile MNone
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7. Accelerated Connections SIP Trunking Configuration

Accelerated Connections is responsible for the configuration of the Accelerated Connections SIP
Trunking Service. The customer will need to provide the IP address used to reach the Avaya IP
Office at the enterprise. In the case of the compliance test, this is the Avaya SBCE public
address. Accelerated Connections will provide the customer the necessary information to
configure the Avaya IP Office and Avaya SBCE including:

e [P address of the Accelerated Connections SIP proxy
e Supported codecs
e DID numbers

It is also important to note that on the Accelerated Connections Genband S3 session border
controller, the sipdialogidentification flag must be enabled to allow proper operation of the
session timers (e.g., long duration calls) and enterprise to enterprise calls dialed using the DID
numbers. If interoperability issues arise, the state of this flag should be checked.

8. Verification Steps

This section provides verification steps that may be performed in the field to verify that the
solution is configured properly.

8.1. System Status

The System Status application is used to monitor and troubleshoot IP Office. Use the System
Status application to verify the state of the SIP trunk. System Status can be accessed from Start
- Programs = IP Office = System Status.

The following screen shows an example Logon screen. Enter the IP Office IP address in the
Control Unit IP Address field, and enter an appropriate User Name and Password. Click
Logon.

IP Office R8.1 System Status CEX

AVAyA IP Office System Status

Help Exit  About

Online | Sffline

Logon

Control Unit IP Address: [plicrdbii

Serwvices Base TCP Port: ELE

U HNETH Aduinistrator

Password: .............l

M Auto reconnect
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Select the SIP line under Trunks from the left pane. On the Status tab in the right pane, verify
the Current State is Idle for each channel.

IP Office System Status

Abouk

Alarms

SIP Trunk Summary

Peet Domain Name: 10.32.1258.20

Resalved Address: 10.32,128.20

Line Mumber : 21

Mumber of &dministered Channels: 10

Mumber of Channels in Use: a

Administered Compression: G711 Mu, G711 A, G729 4, G7231
Silence Suppression: Off

SIP Trunk Channel Licenses: Unlirited . 0%
SIP Trunk Channel Licenses in Use: i}

SIP Device Features:

her Party  Directi... Round R ] Transmit Trans...
i_all Trip D... Ji Jicter

1 le | 00:07:43 ”~
2 Ide |i6days... F
3 Idle |16days...
4 Idle |16days...
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8.2. Monitor

The Monitor application can also be used to monitor and troubleshoot IP Office. Monitor can be
accessed from Start = Programs > IP Office = Monitor. The application allows the
monitored information to be customized. To customize, select Filters - Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this
example, the SIP Rx and SIP Tx boxes are checked.

A B
T1 | VPN | WiaN | SCN

ATM | Cal | DTE | ECorf | FrameRely | GOD | H322 | Interface
1SON ] Kep/Lamp I Directary ] Media ] FPP 1 R2 ] F\nuting] Services  SIP I System

Events

W Sip |[High - [~ STUN
Packets
[ SIP Reg/Opt R [ SIP Misc Rx
[~ SIP Reg/Opt T [ SIP Misc Tx
[~ SIPCallRx [ Cm Motify R
[~ SIPCall Tx [ Crn Motify Tx
v Sip Rz [ hex IF Filter [nnn. ann. ann. nnn)

v SipTx [ hex

Default All | Clear Al | TabClear &l | TabSetal ok | Concel |

Save File | Load File | Select File |

9. Conclusion

These Application Notes describe the configuration necessary to connect Avaya IP Office 8.1
and the Avaya Session Border Controller for Enterprise 6.2 to the Accelerated Connections SIP
Trunking Service. The Accelerated Connections SIP Trunking Service is a SIP-based Voice
over IP solution for customers ranging from small businesses to large enterprises. It provides a
flexible, cost-saving alternative to traditional hardwired telephony trunks. The Accelerated
Connections SIP Trunking Service passed compliance testing. Please refer to Section 2.2 for
any exceptions.
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10. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com.

[1] IP Office 8.1 IP500/1P500 V2 Installation, Document Number 15-601042, Issue 27m, July 2,
2013.

[2] IP Office Release 8.1Manager 10.1, Document Number 15-601011, Issue 29u, April 5, 2013.

[3] IP Office System Status Application, Document Number 15-601758, Issue 07a, November
26, 2012.

[4] IP Office Release 8.1 Administering Voicemail Pro, Document Number 15-601063, Issue 8b,
December 11, 2012.

[5] IP Office System Monitor, Document Number 15-601019, Issue 03c, March 1, 2013.

Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and
™ are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks
are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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